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Introduction

This document describes how to use the IRQA plug-in for IBM Rational Software Architect. The IRQA Plug-in
allows the user to associate his requirements from his IRQA projects to the use cases of IBM Rational Software
Architect. The user will also be able to see the Traceability Matrices saved in the IRQA project, check the
information associated to the requirements or modify requirements directly from the Software Architect Framework.

All the changes made with the Plug-in are stored in the Software Architect project, with the exception of the
changes made in the requirements which are stored within the IRQA project.

IRQA 5]

i b
| REQUIREMENTS |
Ll

IBM Rational
Software Architect

o

USE CASES

(

SA MODEL

3

2

—p Redquirements, attributes, documents, matrices

e Changes on requirements (name of description)

C/ Labrador, 1- 28760 Tres Cantos (Madrid)

Telf. 91 806 17 13 Fax: 91 804 39 50 IRQA Integration with IBM Rational Software Architect



visure

the requirements company www.visuresolutions.com

How to install the IRQA Plug-in

To install the IRQA plug-in, decompress the “IRQA Plugin.rar” file and copy it into the desired folder.

Note.- If the plug-in to be installed is for version RSA 7.5 or subsequent, a previous step should be done. Open
RSA and select Window->Preferences, select then the “General” folder and expand it, after that select the
“Capabilities” sub-folder and in the right hand side of the panel check the option “Classic Update” and finally press
the “OK” button.

Open RSA and select Help->Software Update-> Manage Configuration

ftware Architect
tata Run Window | Help

B
- J g - [dy) Welcome

Q==|> = (7} Help Contents
‘I Search
Dyvnamic Help

Key Assist.., Chrl+Shifk+L
Tips and Tricks. ..

Documentation Feedback

Web Resources

|7 Tutorials Gallery
#4 5amples Gallery
Cheat Sheets. ..

4% Process Advisor
£ 3.]

Process Browser

sare pdates d = Find and Install...
License Status 53 Manage Canfiguration

About Rational Software Architeck |

From the management view select the “Add an Extension Location” option:
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Product Configuration
File

we® e |OE
E@ Rational Software Architect

5 C:\Program Files\IEMSDPFO

Ci\Documents and Settings|cherranziDesktopisa plud | This is the description of the current configuration,
CH\Program FilesiIEMSDP70Shared

=loix|

Rational Software Architect

Available Tasks
Sican for Updates
Seatch for updates for all the instaled features.
‘Wiew Installation History
View all activities since the installation of the product.
Show Activities
Wiew the activities that caused the creation of this configuration,
Add an Extension Location

Locate and add an extension location ko the current configuration. An extension location
conkains Features and plugins previously installed.

BEevert to Previous

‘You can revert ko ane of the previous configurations if you are having prablems with the
current one,

4| | 3
Rational Software Architect

From the “select folder” dialog select the folder where the IRQA Plug-in is contained and then click Accept and
restart the application.

Select an extension location. An extension location is a
directory named eclipse, which contains the i
.eclipseextension marker file, as well as the features and

@ Deskiop

; @ My Documents
@ My Computer
B My Mebwark Places
{21 DooRsa.1

S

{.'Q pruebas migradar
-] Redist

EI{:I sa plugin

{7 wriDoors
-] %RT's wabco

Folder: I eclipse

QF I Cancel Tevs Folder

%
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How to run the IRQA Plug-in

To run the IRQA Plug-in, click on the “Open a perspective” icon | in the top right corner of your IBM Rational
Software Architect main window, choose others and then “Integration with IRQA”.

# openperspective x

9 Crystal Reports

%CVS Repository Exploring
FE Drata

fﬁ‘ Debug

3} lava

E»'-,JJava Browsing
E"Java Type Hierarchy
@Modeling

= Plug-in Development:
Fﬁ]RF\S {Reusable Assets)
[£ requirement
Li"‘_—,Resnurce {default)

L&) Rule Builder

QDTeam Svnchronizing

[ show al

oK I Cancel |

Additionally, the plug-in can also be opened in the Open perspective option, in the Window menu.
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How to use the IRQA Plug-in

Elements in the Plug-in
There are 5 different views in the IRQA plug-in:

The requirements explorer view

This Tree view contains all the elements (projects, requirements in a hierarchical view and traceability matrices)
associated with the open repository. From this view the user can:

0 Open or close a repository,

0 Add or remove a relationship between a requirement and a use case

0 Setup the requirement view

0 Modify a requirement

=i | :Integraciuﬁn Fo =

quirement Explorer. = e =0
=~ _} ZCC Syskem - 25 appliances _ﬂ

b [[E ZR_0010; Computerised Central Control (CCC) syskem

AR cr_o0z0;: €CC System modes

[[B ZR_0030: Appliance working modes

I cr_no40: Manitoring

IIE CR_0050: Working mode monitaring

IIB’ CR_0060: Pre-pragramming

:-- [[B’ FUMC_0010: Computerised Central Control (CCC) swskem

CI [[E’ FUMC_0015: CCC Systemn modes

: II@’ FUMC_0100: Supported Bandwidth

[[B FUMC_0200: Loading and unloading of appliances

- [[B FUMC_0300: Appliance warking modes

S = MR R

Buttons in the explorer view:
0 Toolbar:

] @ : Open a repository
" E : Close a repository
. & : Update
= @7 . Relate
o Contextual Menu:
= Over a project:
o = Update

. Eg Setup requirement information view

C/ Labrador, 1- 28760 Tres Cantos (Madrid)
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. @ Synchronization

« @ Open relationship window

= Over arequirement:

o« F Change requirement

The requirements information view

From this view the user can check the information associated to a specific requirement. The attributes which are
showed here can be formed by the user or loaded from an IRQA configuration.

| T =
Propetties HE Requisite Information &5 \\Traceability Matrizes | Related Requirement | Related Use Cases | |
Attribute | alue |
Code FUMC_0410
Mame Warking made monitoring

The Traceability Matrices view

This view allows the user to see the traceability matrices between requirements by motive which have been
previously saved in IRQA. The user will not be able to modify the matrices from the IRQA Plug-in, but only visualize
the relationships.

Properties | Requisite Information gs M Related Requirement | Related Use Cases| = m

| cr_onio:com... |cro.. |cro.. |cro.. |cro.. [cro.. [cro.. [Fun.. |Fon... |Fum... | <]

FUMC_0610: Routing s...

FUNC_0620: Firewall

FUMC_0630: Remaoke ..,

FUMC_0635: Instructio. ..

FUMNC_0645: Protocal ...

FUMNC_0655; External ...

FUNC_0665: Local net.. .

FUNC_0670: Self diag...

FUNC_0630; Self diag...

FUNC_0690: Self diag...

FUNC_0700; Self diag...

RMF{Fia_D100: Accum. ..

RNF/Fia_0200; Issue ..,

RMF{Fia_0300;: COC 5., o

RMF/Oper_0100: Platf...

RNF/Oper_0200: Persi..,

RMF{Oper_0300: Supp... o o
RNF/Oper_0400; Auto...

RMF{Oper_0500: Metw, .. av

<| I »

C/ Labrador, 1- 28760 Tres Cantos (Madrid)

Telf. 91 806 17 13 Fax: 91 804 39 50 IRQA Integration with IBM Rational Software Architect



visure

the requirements company www.visuresolutions.com

The Related Requirements view

After selecting a use case from the UML diagram the user can check which requirements are associated with the

selected use case.

Propetties | Requisite Information | Traceability Matrizes Related Use Cases| =

----- HB CR_0050: Working mode monitoring:

The Related Use Cases view

Similar to the associated requirements view, this view allows the user to see to what use cases the selected

requirement is associated to.

Properties | Requisite Information | Traceability Matrixes | Related Requirement

Opening a project

To open a project click on the “Open repository” icon on the requirement view toolbar. This will open the following

dialog:

C/ Labrador, 1- 28760 Tres Cantos (Madrid)
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Open Project N

—Authoritation i~ Repositories
Logir: =
| admin IRGA Tutorial Reusabilicy _l
Password:

Validation Syvsten

IIRqF'. Lsers ﬂ

Domain narne:

| =l
Server Marme:
I Refresh Repositaries |

Projeck

CCC Svstem - 25 appliances
CCC Syskem - 50 appliances
Standards and Morms

Accepk | Cancel

In this dialog the user must enter the login, password and user group and the desired repository and project.
This dialog works like the open project dialog in IRQA.

Once the project is opened, the Requirements explorer view will look like this

|=._‘f| B Inteqracion ... b
BEE =0

B- ﬂ CiCC System 25 appllances -
[[@' CR_0010: Computerised Central Contral (CCC) swstem
R cr_o020: CCC System modes
[[E' CR_0030: Appliance working modes
-l cr_oo40: Monitoring
[[B' CR_0050; Working mode monitaring
[[E CR_00&0: Pre-programming
[[Q" FUMC_D010: Computerised Central Conkrol (CCC) syskem

I [[E‘ FUMC_0015: CCC System rodes

i [[E’ FUMNC_0100: Supported Bandwidth

[[E’ FUMC_D200: Loading and unloading of appliances
[[Q' FUMC_0300: Appliance warking modes

e AR

From this tree the user is able to view the requirements of the selected project and the traceability matrices
saved in your project.

C/ Labrador, 1- 28760 Tres Cantos (Madrid)
Telf.: 91 806 17 13 Fax: 91 804 39 50

IRQA Integration with IBM Rational Software Architect 11



visure

the requirements company www.visuresolutions.com

In the same way, the user can update the project with the information from the database so the changes that have
been made since the user has the project opened can be applied. To do this, the user must click on the “update”

icon &l in the toolbar. This can also be done by right clicking on the project and choosing update project from the
contextual menu.

Checking requirements information

The requirement info can be checked by selecting a requirement and choosing the “requirement information view”.

f T
Propetties EE Requisite Information &2 \Jraceablhty Mattixes | Related Requirement ‘ Related Use Cases | = |
Attribute | Walue |
Code FUMC_0410

Mame Working mode monitoring

From this view the user can check the attributes associated with the selected requirement and its values. The list of
attributes shown can be modified by just right clicking on the project folder in the “requirement explorer view” and
choosing “setup requirement information view”.

T Elntegracién £l 22
BE @ -0

-

ke

[[E o == tup requirement information view

[[Br C @ Synchronization
[[B’ C @r* Open relationship window
CR_T0ST: Working mode monicoring
[[B CR_00&0: Pre-programming
[[B FUMC_0010; Computerised Central Contral {CCC) syskem
['I"[[B’ FUMC_0015; CCC Swskem modes
LA Fome ntans Sinnarked Randiidkh

This will lead to a dialog window were the user can add or remove predefined or user defined attributes to the
“requirements information view”. To do this, the user must select the desired attributes (one by one or a multiple

>

selection with the CTRL key) and click on the right arrow key

In the same way attributes can be removed from the view by selecting them and then left click on the left arrow

<

You can also order your selected attributes using the up and down arrows.

C/ Labrador, 1- 28760 Tres Cantos (Madrid)
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Finally, the IRQA plug-in can import the user view configuration from IRQA. Selecting one of these views in the
combo box on the bottom left corner of the dialog

| =l
Conf 1

Conf 2

" Configuracion

Default

Predefinidos

will add the attributes within the saved configuration to the user view.

Modifying requirements

The user may modify the requirements from the “requirement explorer view” by right clicking on the desired
requirement and choosing the “modify requirement” option from the contextual menu.

] | Bl Integracidn c... 2]

= Requienent Bplorer. x N B Dk & & — O

B coc System - 25 appliances -
[[9' CR_0010: Copa dend o : St

AR cr_onzo: cc i

IIE ZR_0030: Appliance warking modes

-l cr_n040: Manitoring

IIE (ZR._0050: Working mode monitoring

[[@’ CR._00&0: Pre-pragramming

IIE FUMC_0010; Computerised Central Contral {CCC) swstem

EEI--IIB’ FUMC_0015; CCC Syskem modes

HEZ FLIRE 1 0ne Sommevkad Bandisidbb

Zhange requirement

This will lead to the following dialog window

Edit requisite 1

—Requirement
Mame:

I “CC System modes

Description

The CCC system will support different control modes. 0O

Arccept | Zancel |

From here the user can modify the name or the description of the selected requirement. The changes will be also
exported to your IRQA project.

C/ Labrador, 1- 28760 Tres Cantos (Madrid) IROA Int . ith IBM Rati | Soft Architect 13
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Working with associated files in Software Architect

The IRQA Plug-In allows the user to see the documents associated with a requirement from the “Requirement
explorer view” as shown in the image:

=l 0010 Requisite 001
I'_i_wl This document describes the IRgA plug.doc:
+ [[B REQ-0001: Momem_D0001

Additionally, the user may open these documents by double clicking over the document or by right clicking on the
desired document and selecting “Open” from the contextual menu

= I 0010: Requisite 001
4R This d

+ [ REQ-0001 ¥ Open

+ -l REQ-0002: Name_0002

&

the IRgA plug.doc

Relating Requirements to Use Cases

To relate an IRQA requirement with a Software Architect use case, the user must select the relate option from the

IRQA Requirement Explorer toolbar d o right click on any project and choose “open the relationship window”
from there after opening the project.

This will lead to the following window

Relate uses cases with requirements

EHCT) Use Cases B+ e System - 25 appliances ;I
E::r Use Case Model [[E CR_0010: Computerised Central Control

2 $luse.case} JIB’ CR_0020: CCC System modes

L UseCasel HE CR_0030: Appliance working modes

I cR_0040: Manitaring

JIB CR_0050: Working mode monitoring

HE CR._0060: Pre-programming

{[B FUMC_0010: Computerised Central Cant

I']--[[B FUNC_D015: CCC System modes

HE FUNC_0100: Supported Bandwidth

JIB’ FUMC_0200: Loading and unloading of a

HE FURC_0300: Appliance working modes

-{[r FUNC_0400; Manitaring

JIE FUNC_D410: Working mode monitoring

HE FUMNC_0430: Pre-programming

[B’ FUMC_0440: Pre-programmed states

I']--[[B FURC_0500: Event registration

{B’ FUMC_0610: Routing security

Ry PUNC_0620: Firewall
H o =S N
4| | » |

Accept | Cancel |

The right panel will display all the requirements from the IRQA project in a tree view, and the left one will be filled
with the use cases from the opened models in Software Architect.

C/ Labrador, 1- 28760 Tres Cantos (Madrid)
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In order to start relating requirements with use cases, simply drag and drop the chosen requirements from the right
tree to the use cases on the left tree. If the selected requirements are already related with the chosen use case, the
drag and drop won't be allowed. Also, if some of the requirements are already related a warning window will pop up
and advise the user of this situation.

If the user clicks on the Accept button, the non related requirements will be related.

The user may also unrelated requirements from use cases. In order to do this, the user must select the chosen
requirements from the left panel and press the delete key.

Finally, once the changes are made, click on the Accept button to save them or cancel to ignore them.

Updating and synchronizing requirements

The user is able to update his requirements in the IRQA project clicking on the Update button in the Requirements

explorer toolbar 2l o by right clicking on the chosen project folder and choosing update from the contextual
menu.

This will cause the project to be closed and reopened, retrieving the information from your IRQA repository.
However, this won't update the names of the requirements associated with the use cases. To do this,
synchronization will be needed.

The Synchronization option from the contextual menu allows the user to update the requirements in his Software
Architect project with the information in the IRQA repository in four different ways:

1. Synchronization notifies the user when a requirement has been deleted, deleting it also from the Software
Architect project.

2. It also notifies when the version of a requirement has changed.

3. Finally, if the name of a requirement or the code has changed, the synchronization will notify the user and
will update the names and codes of the requirements associated with the use cases.

To Synchronizate the project, right click on the project and chose Synchronization from the contextual menu.

This will lead to a dialog window where the user may see the requirements affected by the synchronization and the
action that has been fulfilled.
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